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��2��"�����������  
1. ���������	
�����
�������
�� (Calibration) 

��	�
��2����������� Activboard ��������,������"2�"��� ����&0�"�
�������&��+"������  

(Calibration) ActivBoard ��� ActivPen ��
� ��	�
�,�&��)&�����
� AcitvPen  

��������* (���4�+�,���������) �
�2���"�����  

������
)!��+�����������!)�����* ActivPen �!+�-��������"��� # �
��
��2!�"
�*  

+������� ActivBoard /������
 ������
)!��+�����������*�
��
��2!�"
�* 

!21
���&��+"������ (Calibration) 

1. ���&��)&���� ActivPen /&��
�-�����+�'��)�
� ActivBoard +�2�!6 Logo /?��� #

&����6 5 – 6 !2���
 

2. ,��������������7�����&�
�)��&0��
��! �,���&��)&����+�72!������ 1 ����� 

3. ���������&��)&������+����	�
�,��)+!� '���&���G
)��+�����������!� 5 �-� 

4. �����"&��)&�����
�����+����������!��"�
����"����+�����* '���,��)(����2��������/��

����
 

 

 

 

 



The ActivClassroom prometheanby 5

2. ��
�������������� ActivPen  

 &���� ActivPen �
���56����������������
)!��+�����*  

�������
��������
������

������ 

���7��&��)&������+��������+� # (%�)/��"�
�

��������/&)  

���	�
�&����/&�
+ # ������ ���4��
������*�����	�
�"��&��)&���� 

�����!�"��# 

���7��&��)&������+������� %�)

������
)����!���J! 

�����!��$� 

��
&��)&����/!�+��	��72!�
������� (%�)/��"�
��,�&�������7����/& 

+��	��72!�
�������) ���!��&-K��
���+�&������	�
��������2��!� 

�����!������� 

��2�'��)��+�!�"(-�
�"�
���������	�
�)��) ���	�
��
�&����%�)�
�&��) 

&����)�������7��
)���
�!�"(-"�
� !�"(-�����	�
�)��)"��&��)&���� 

���%����!	���!� 

���7��&��)&������+�������%�)�,�

������
)����!���J!����!� 

�
������ �,�	
������+�+2����2��
������* 
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3. &���$�����'����� Flipchart 

Flipchart �&0��	�
��
)��
�����
���������%&����� ActivInspire %�)�
 

���56��,�	
���+,��������5 �
���������(��2������!�,���/��
)���/�������� 

������)�������(��2���	�
"��� # ��/&+�,��� Flipchart /�������) 
��2  

��
)� !2�
%
 3�����	�
�/,! �!J+/'"* �!�/&(���2�����"��� #  

Flipchart (?�2&���*") �&0�/?�*�����-� .flipchart ��������(+�����  

Flipchart �� Thumbdrive /�� ��������(���/&��
)��&.� Flipchart  

����
��2!�"
�*�-����	�
��
�/����%&����� ActivInspire /!���
)+��
)���! 

 

4. �����*%+������ ActivInspire 

��	�
��%&����� ActivInspire ���J����! ��$���56* ActivInspire  

��&���G
)��+�,��� Desktop 

��+�+2����2���$���56* ActivInspire ��	�
�&.�%&����� 

,���
��
�!���� # �����������,���	
� OK ��&���G ActivInspire Dashboard ������ 

  

 

 

 

 

��2��
� Create a new flipchart ��	�
����� Flipchart �������,�� 

�����2��
� Close ��	�
������&.� Dashboard   
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5. ���

�����

��
���� (Main Toolbox) 

,�������&.� Flipchart ���������! ��&���G���
����	�
��	
"��� # �����& 

 %�)���
����	�
��	
,��� (Main Toolbox) ��&���G��������!��
�,��� Flipchart 

   

 

 

 

 

 

 

 

 

 

6. �����

��
����� (Pen Tool) 

���	�
��	
&���� (Pen Tool) ��
)�������
����	�
��	
,���  

��2���	�
��	
����������&���� %�)��	�
��	
����	�
��	
�
����! /
�
�&�������!�������  

��$
#��
  
��
)����!�� Welcome ��+�,��� Flipchart 

%�) ��&��)&����+�72!+
�*�����/!��� 

��
)����J���
)+��
) �����&  

���
����	�
��	
,��� 

Menu bar 

���	�
��	
&���� 
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7. �����

��
 Undo ��� Redo 

���	�
��	
 Undo �����(���)���2��������"��� # �
������2�������/& 

�!�/&(�������()���2���������
�������72�/&/����!)  

 ��$
#��
 

 ��2� Undo ��	�
)���2������
)� Welcome  

  

 

 ��������(��2� Undo '�����	�
)���2��������)�
�,���/&��	�
) # /�� 

 

 

 

 

 

 ���	�
��	
 Redo �����(����,����)�
�������������� ,�	
)���2���������
���� Undo /&/�� 

��$
#��
 

��2� Redo ��	�
��
)����!�� Welcome ���+�	��� 

 

 

������
)!��+ Undo ��������(��2� Redo '�����	�
��
)��������)�
����+����	�
) # /�� 
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8. ������,�#��,������%�

���������  

 ��������(�&�
�)��
��������
������,���+&����/�� 

 %�)��2���	
��
����	�
��	
����+�  
 

 

��$
#��
 

��
)����!�� To (����� Welcome 

%�)��	
��
������2������������&�����,$��
��-� 

 

 

 

9. �-����
����%��������� (Pen Width Selector) 

��������(��	
�&��+��������&����/��"��"�
���� 

%�)����(+�����������"�!��	
���������&���� 

����'��)�-��
��(+�	
��������&���� 0  

�����!��-��
��(+�	
��������&���� 100   

 

��$
#��
 

��
)����!�� ActivInspire 

%�)��	
���������&�����,��,$����� 

�����	
�����&�����
���  

"�!��	
��
 

"�!��	
��������� 

�(+��	
��������� 
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10. �����

��
�����������
�$�� (Highlighter Tool) 

 ���	�
��	
&����������
�!���
� �������+�2�!6��
�!�������$�,��&0��
������"/�� 

 ��������(�&�
�)��
������������
�&����������
�!��/��������
)!��+������&���� 

��$
#��
 

�������!�� Welcome %�)����
�,�	
���� 

�������!�� To %�)����
��
)! 

 

 

 

11. �����

��
#�
�� (Eraser Tool)  

���	�
��	
�
�������,��+�+�������&����,�	
�������&����������
�!��/�� 

��������(�&�
�)������
�)���+/��������
)!��+������&���� 

��$
#��
 

�+���!�� Welcome ��� To +����!�%�)���)���+ 
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12. �����

��
������ (Select Tool) 

���	�
��	
�
�����,���������(���	�
�)��)!�"(-"��� # /�� 

,��������	
����	�
��	
�
����! ��	�
��2�������!�"(-  

���,J�!�"(-���	�
��
�"��'�����������(���/&)��+�2�!6"��� # �
�"�
����/�� 

��������(��2������-�!�"(-,��) # �2�� ��	�
���	�
�)��)���
����/�� 

 

13. �����

��
-�
�#� (Flipchart Bin) 

���	�
��	
(���)���
)��+�,��� Flipchart  

��������(�+!�"(-"��� # /��%�)������	�
��	
�
� 

��������(�&.�-&.����������(���)�/�� 

%�)��2��
� Menubar ����+� �����	
� View > Flipchart Bin 

!21
����+!�"(-�����(���/��%�)�
�!21
 ����
� 

1. ��2���	
����	�
��	
�����*  ,������������2��
�!�"(-�
�"�
�����+ ���!��2��
�(���)� 

2. ��2���	
����	�
��	
�����*  ,������������2�������!�"(-�
�"�
�����+��!��/!��
�(���)�  

!�"(-�
�(���+/&���!��������(��
)����+��/��%�)���������� Undo  
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14. ������&/� Flipchart 

��2���	
��
�����,��� (Main Menu)   

+�2�!6����+��
����
����	�
��	
,���  

��	
� File > Save 

/?�*�
�+��������&0������-� 

.flipchart 

 

 

 

 

"�!
)���/?�*�
�+����� �	�
 Flipchart1 

 

 ��������(��+�+2����2�/?�* Flipchart �
� Save /�� ��	�
�&.�������/������
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15. ����:!������ Flipchart 

 ��	�
���� Flipchart ���&0��
��������),��������5 

 ����,���������(��2������!�,��� Flipchart /��
)���/�������� 

�����2��,��� Flipchart ���/��%�)��	
�������� Next Page ���  

Previous Page '��������
���������
���
)������+��
����
����	�
��	
,���  

 

������� Next Page  

 ��	�
��	
���������
����&0���������,��� Flipchart �&��� 

 ,���(��/& 

  ������� Previous Page 

  ��	�
��	
���������
����&0�������+/&)��,��� Flipchart �
����! 

 

��������(���������������
��
�������&�
�)�/&��,��� Flipchart  

(��/&,�	
,���)�
�,���/�� ������
)!��+���
���,����	
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16. �����

��
'�%��,#
���� (Page Browser) 

���	�
��	
�
���
)��+�,���"��� Browser 

���
)��+����
����	�
��	
,��� 

%�)&�"2,���"��� Browser �
���(��'�
��
�/!� 

��	�
�����������*/&�
����� # ,���"��� Browser 

����	�
�

��� 

��	�
��2���	
����	�
��	
�
� ��&���G,��� 

Flipchart �
�����

)������,�� 

 

 

 

 

 

 

 

 

 

 

 ��������(��2��
�,��� Flipchart �
�"�
���� ��	�
/&)��,��� Flipchart ����/������
 

 %�)���
��
+�
��� ����,��� Flipchart �
������
)����
)�����!������ 

  

Page Browser 
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17. ���'�%$�
�������
���

�����

��
���� 

 ��������(���!��"���,������
����	�
��	
,����,�
)��"��"���,����
�"�
����/�� 

 %�)�����2��������(+�
���+����
����	�
��	
,���  /&!��)��"���,����
�"�
���� 

 ,�	
�����(��2�����������!��"���,���  ��&���G��������,���	
� 

� Dock Left  : ������
����	�
��	
!������'��) 

� Dock Right  : ������
����	�
��	
!�������!� 

� Dock Top  : ������
����	�
��	
!������+� 

� Dock Bottom  : ������
����	�
��	
!���������� 

� Floating  : !��"���,������
����	�
��	
/��
2��� 

 

��������(���!��"���,����
�(���)� 

%�)�����2�����������(+�
�������+�/��������� 

 

��$
#��
 

���
����	�
��	
,���
)���������� 

��������	
� Dock Bottom  
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��
�!�� 

��������
�!����+� ActivInspire ������,�+���
)��������������
��"�^��)2������ 

���)������,���������(��� Flipchart �
�������&0��	�


���������'���/����	�
) # ��,�!��
�
� 

���&0����
12+�)�����������
�!���
�%&����� ActivInspire �����56�"��� # 

 

1. ��������
�$�� 

 ��������(�2��*��
�!��/������
 ��	�
�&0���������
�!����+�,��� Flipchart 

 ��
�!���
��2��*��������
)�������56����
���
�!�� 

��$
#��
  

�2��*���!�� working with text 
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2. ���

�����

��
���;���
�$�� (Text Edit Toolbox) 

 ��	�
��2���2��*��
�!�� +�2�!6����+���&���G���
����	�
��	
���/���
�!��  

 ���
����	�
��	
+�2�!6�
��&0�"�!&��+�"����
�!���
��������2��*
)�� 

 

  

  

 

��	�
��2��
��
"�!
��5�,�	
�
�	��,���"�!
��5���&���G�
�,���	
� 

        ��������(��	
�"�!����
 

       ��	�
����
����
�
	�������/������
 

���,��+���+�����	���
��
��!�	
/���
�
 (�_����
�	��,���"�!
��5�) 

        

 

 

 

 

 

 

 

 

Font "�!
��5� &��+���� 

��2������ 

������ 

"�!�

)�

"�!,�� �
������"� "�!,�
) 

"�!)� 

�
"�!
��5� 

�
�	��,���"�!
��5�

"���,�����
�!�� 

&��+��)���,!���

+�����

&��+��)�)�
,��� 

,�!��
 

�
)*+
�*�+�,����


��	
�����,��

��$���56*�2�45
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3. �,#��
��%����
�������'
 (On-Screen Keyboard) 

���	�
��	
�
�
)�������
����	�
��	
,��� �&0����	�
��	
 

�
��������
)*+
�*����	
�+�,����
 �
&��%)��* 

���,��+�2��*��
�!��7������������ ActivBoard 

�
)*+
�*�"�!�
��&0��
�%&����� ActivInspire ���/�������(�2��*3�5�/�)/�� 

 

��������(&��+�&0��
)*+
�*��,������(�����!���+3�5�/�)/�� %�)���&����/&�
�  

Menu bar ��	
� File > Settings 
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���������&���G,���"��� Edit Properties�,���	
� User Input ���!��	
��
�  

Use keyboard supplied with operating system 

                                                    

 

 

 

 

 

 

 

 

 ��	�
���+/&��2��
����	�
��	
�
)*+
�*�+�,����
          

��������/���
)*+
�*�
���,�������� 

 

 

 

 

�
)*+
�*��
�/�����&0��
)*+
�*����%&������
� Window '��������(�2��*3�5�/�)/�� 

User Input
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4. $!=,���;���
�$�� 

 ��
�!���
��2��*/&���! �����(������+�����/�/�� 

��2���	
��
����	�
��	
�����*  ���������+�+2����2���
�!���
�"�
���������/� 

 ��&���G���
����	�
��	
���/���
�!�� �����(���������/���
�!��/������
 

 

5. �����

��
���
��#��
 (Recognition Tool) 

���	�
��	
�&����)�	
��!)�,���������(�&����
�!�������)�	
��
)�/&�&0���
�!���2��*/��

%�)
�"%���"2 ���	�
��	
�
��
&��%)��*�����	�
���7��������� ActivBoard 

 

%�)��2��
�"�!��	
����	�
��	
+����
����	�
��	
,��� 

��	
� Handwriting Recognition 

 

 ������������(��
)���
�!��/������
 %�)�2���
������
)�/& 

 ��(���&�������)�	
���&0�"�!�2��*����
 

��������(����
�,���+��
�!��/��  

%�)��	
��
��
��
�����2����������
)���
�!�� 
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��$
#��
 

��
)����!�� school �����
�!���
�/���������&����&���G�����& 

 

 

 

  

����
��&����)�	


������� ,��/��"����+����
������
)� 

�����(��	
��&�
�)����/������
 �����&  

  

 

Shape Recognition ���&0�"�!�&����&����
������
)��,��
���56��!)���)2������  

 %�)���56�������������,�	
���+���	�
��	
�&����)�	
 

 

��$
#��
 

��
)���&������ ��&����
�/���������&����&���G�����& 
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������
��� 

%&����� ActivInspire �����
���+������
��� (Resource) '���&���
+/&��!) 

��&3�� �	��,��� "���� ��
)� /?�*�?�� /?�*?�2&���*""�!
)��� ���+���
)������J���&  

����!��,�4�� �
������(�������������+���
)��,�����������)2������ ���������
����
� 

)�������(��J+��
�����!�"�!������2��/&/��

���!) 

 

1.  ��!��������
�����
��
��� 

��2��
� Resource +��(+,���"��� Browser 

,�	
+����
����	�
��	
,���  

+�2�!6 Browser ������������
���������  

��!�&���
+,����
�������
����+���&0� 

�
���!��	
 

 My Resources 

  ��!�����������
�����!�"�! 

  Shared Resources 

  ��!�����������
������!/& 

 ���,��+��
����
������
���+ ActivInspire 

 ��
)���� Shared Resources 
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2. Shared Resources 

 ����!��
� Shared Resources ��&���
+/&��!)��!������$�����!� �����& 

  
"�!���,� �����(���,���&3��/���
��
� 

�2��*�	�
3���
�"�
�������,� ���!��2�  

Start Search           ��	�
���������,� 

��!�����,�!��
�� Shared Resources 

��!�������
�����,�!��
�
���������	
�
)�� 

3��"�!
)���������������&3�)��,�!��
 

Shared Collection > Art & Design 
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3. ��$��
���
 > ?�#�� Shared Resources 

��
���3�)�� Shared Resources &���
+/&��!) 3�� ��
)� /?�*"�!
)��� /?�*�?�' 

�+��"��,�!��
�
�������� ����
� 

Shared Activities  : �!+�!�/?�*�?���
������(���������&0��2�����/��  

Shared Annotations  : �!+�!���)����&��������&�++"��� #  

 Shared Backgrounds  : �!+�!�3���	��,��� 

 Shared Collections  : �!+�!���&3��"����)!2��    

 Shared Flipchart Pages : �!+�!�,��� Flipchart "�!
)��� 

 Shared Flipcharts  : �!+�!�/?�* Flipchart "�!
)���  

 Shared Grids   : �!+�!�"���� 

 Shared Images   : �!+�!���&3�����!/& 

 Shared Shapes  : �!+�!���&����++"��� # 

 Shared Sounds  : �!+�!���
)�"�!
)���"��� # 
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4. ��������
���'�� Resource �����
�� 

��������
���&,���@����?�:&��$;������
�� 

�����(��2���������
���,�	
3���
�"�
���� 



���!��+�,��� Flipchart /������
 

��$
#��
 

���3����	
�+����� Shared Collection 

 

��������
���?�::�	����
���
����
�����
�� 

3���	��,���,�	
"������)��"2� 

��+ Flipchart �����7�� 

��$
#��
 

���3�������������� Shared Background 

 

��������
�����,#
�����
�� 

��
)��
�����������
��$���56*�&0���&���%�� 

��2��
���$���56*���%��

��������	�
������
)� 
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5. ���#�
 (Rubber Stamp) 

 ���	�
��	
"��)����������"��)�� %�)��&�
�&����+���"��)���	
��&�
���	
����������
��� 

  !21
������"��)�� 

  1. ��2���	
���&3���
�"�
���������"��)�� 

  2. ��2����	�
��	
"��)�� 

  3. ��	�
������*

���+�,��� Flipchart ���,J���&3���
���	
������56����  

  4. �����(��2�&����+��&3��+�+�2�!6�
�"�
����/������
 

 

 ��$
#��
 

 �����"��)����&�
"���*���������        

 Shared Images 

 

   

 

 

&����+��&�
"���*��/&+� Flipchart 

�6��
����"��)��
)����������( 

&����+"��)��/��"������!��
�"�
����  
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6. ����:!������
���
��
��� 

��&�
�
)��+�,��� Flipchart �����(+�������������
�����	�
��
)��������3�),���/�� 

!21
�����2����&3���,���2���������&3������/&!��/!�����!�������
���  

��&3��������(��+�������J+/!���������
�������
  

��&3����+���������,�!��
�
������	
����
)�����6����� %�)��������(��	
�+������� 

�
� My Resources ,�	
 Shared Resources �J/�� 

 

��$
#��
 

�����&3����	�
+�������������
��� 

��,�!��
 Shared Resources 

 

 

 

��	�
��������2��!��
���&3����������
���  

��������(������&��+�"����)���

)��,���+��&3��/�� 

� Insert into Flipchart 

�����&3����,��� Flipchart 

� Rename Resource File 

�������&�
�)��	�
��&3�� 

� Delete from Library 

�+��&3��

����������
��� 
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�
�����&��� 

��,�!��
�
����������-6��+�"2"��� # �
����������&����
������(���/&������ 

�� ActivInspire /�� �!�(��
12+�)����!��
����&��+�"���
 ��	�
�,� Flipchart  

�
�!���!)���)2��������!) 

 

1. �����

��
���&�
 (Shape Tool) 

 ���	�
��	
��&����&0����	�
��	
�
���!)������������&���"��� #  

��	�
��2��
����	�
��	
��&��� (Shape Tool)  

���
���&�����&���G��������!��
� Flipchart  

!21
���!����&��� 

1. ��	
��++��&����
�"�
������!�� 

2. ��	
��
��)�����
������&/���
�"�!��	
��
 

3. ��	
��
���,��+�"2���&���/���
�"�!&��+�
 

3�)�����
���&��� 

4. ��2������� !����&���+�,��� Flipchart /������
 

 

 

 

"�!��	
�������&�������,�� 
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2. ��$����
���
 (Connector)      
 "�!��	�
�"�
��������������56�"��� # ��	�
��	�
�%)���&�
���&������!)���   

��	�
��2��
����	�
��	
"�!��	�
�"�
 (Connector) ���
�������	�
�"�
 

��&���G��������!��
� Flipchart  

 !21
������"�!��	�
�"�
 

 ��
�
	�����"�
��������&�
���&�
�"�
��������	�
�"�
/!���
�   

 1. ��	
���&�++������	�
�"�
�
�"�
���� 

 2. ��2��
���&���+��-��
�"�
��������	�
�"�
 

 3. ��2�������/&)����&�
��
�+��-��
�"�
������	�
�"�
 

 4. ������	�
�"�
��(���������	�
���&�����
�������!)��� 

��$
#��
 

�"�
)���&�
���&�
�"�
��������	�
�"�
�
�/!���
� 

 

 

 ��2�������������	�
�"�
�����
��-�������!)���  
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3. �����

��
-�
�, (Fill Tool) 

 (���
������,��+�&�
�)��
!�"(-�,��
�
"��� # "��"�
���� 

!21
������	�
��	
(���
 

1. ��2��
����	�
��	
(���
 

2. ��2���	
��
���"�!��	
��
 

3. ��2����
��+�2�!6�
�"�
�����&�
�)��
/������
 

 

 ��$
#��
 

!����&�������
���������%�)��� 

���	�
��	
�������&���  

 

 

��2��
����	�
��	
(���
 �����2���	
��
�,�	
�  

 

��2��
�+�2�!6�	���
��
���

������  

���&0�������
�,�	
��
������	
���/&����
��
��� 
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4. ����:!��'���$��,��������$���
��, 

 ��������("�������!��
�,���+"�!��	
��
/�� 

 �
� Menu bar 

 ��	
� Edit > Profile 

  

  

 

��&���G���
� Edit Profiles ������ 

 ��	
��
� Main Toolbox ���!��	
�����!��
�
�"�
���� 

�
�
�,���	
�����++�	
 8 �
 16 �
��� 24 �
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��&3�� 

/��!�����&0�3�����
2��"
�*��J",�	
����?|�3�� ActivInspire �J�����(��2���
��� 

����������,��-���,����������++���
)��
�7���
�������
/�� ��	�
,���,�!��
�
����&0� 

�������������2��
���������(�����2����������,���+��&3��/�� 

 

1. ����������%���?�: 

 ��������(&��+������&3������,��+�,��� Flipchart 

��2���	
����	�
��	
�����*            

���������2��
���&3���
�"�
����&��+����  

��&���G����������/���&3�� �����& 

 

 

���������&!�����
+ # ��&3���&0�"�!&��+������&3�� 

� ��2��������
�        ����������,���� 

���&0����&��+������&3���������� #  

� ��2��������
�        

���&0����&��+������&3���������!���2� 
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2. �����

��
�������
���?�: 

 ��	�
�����2���	
��
���&3�� ���
���	�
��	
&��+�"����&3��&���G������ 

 

���	�
��	
�,����
��
&��%)��*�����&��+�"����&3���,��
�!��,���,��) 

�����2����������,��
�!���������)2������ 

 

3. ������
�����
��������
���?�: (Freely Move Object)  

��2���������	�
���	�
�"���,�����&3��/&)��"���,���"��� # 

��������(��	
����	�
��	
�����*           ��2���������&3��%�)"��/����)  

4. ������
��D����?�: (Rotate Object)  

��2����,�-���	�
,�-���&3��"��"�
���� 

5. ������
�������
���?�: (Object Edit Menu) 

��������&��+�"����&3��"��� # 
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6. ������
��������$��+���
��
�

?�:  

    (Translucency Slider)  

��2���������	�
&��+�!��%&�������
�3�� 

%�)����(+/&���'��)������,�3��%&������������	�
) # 

 

��$
#��
 

 &��+����!��%&�������,���+��& 

 

7. ������
�$���D��������$��-D (Grouped) 

 ��������
�����!�!�"(- (��& ��)���� "�!�2��*) ����!���
�!�"(-����/&�,��&0���-����
)!��� 

 !�"(-�
�
)������-����
)!������&�
)+�,�	
��&0�!�"(-��
)!��� 

!21
����!���-���,�!�"(- 

1. ��2���������
+!�"(-�
�"�
�����!���-�� 

2. ��2���	
���������!���-��!�"(-�,��!�������           ���&0�����!���-���,�!�"(- 
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8. ������
'�%�������
���?�:  

    (Bring Forward, Send Backward) 

��	�
�����&3������+� Flipchart �����"���,�������
�  

��&3���
�(���������
���
)���"���&3���
�����������
,��� 

�����&"�!
)��� ��&�-���(�������+� Flipchart �&0���&��� 

"����!)��&�-����2���
������&,�� 

��������(���!��"���,����,��/�� %�)�������������"���,��� 

������������&������,��� (Bring Forward) 

 ��������
������"���,�����&�,�������
)��"���,���+�,��������   

 ������������&/&����,��� (Send Backward) 

 ��������
������"���,�����&�,���/&
)��"���,���,���,�������� 

 ��$
#��
 

 ��2��
���&�-��������	
�������������&������,��� 

 ��&�-���������������+���&�-����2���
� 

 �"�)����
)���"���&,��
)�� 

 

 ��	
�������������&������,����
���&�-���

������ 

 ��&�-�����������
)������+���&,�� 

 �6��
���&�-�������&�
�)���
)��"���,���+��-����! 
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9. ������
�������%���  

    (Increase Object Size, Decrease Object Size) 

 ���������2��������& (Increase Object Size) 

 ��	�
��	
���������
� ��&���)�)�,$�������J���
) �����(��	
�'�����	�
�,�3���)�)�,$�������	�
) # /�� 

 ���������������& (Decrease Object Size) 

 ��	�
��	
���������
� ��&��&��+��J�����J���
) �����(��	
�'�����	�
�,�3����J�����	�
) # /�� 

 

10. �����

��
����
�N,%�	�� (Clear Tool) 

���	�
��	
"�!�
��
/!�����+�2��"��� # �
�
)��+�,��� Flipchart  

%�)�����(��	
�/��!�����"�
�������+�_�����!�/,�,�	
�+

�����,�� 

��	�
��2���	
����	�
��	
���+
�_
��������!���
"�!��	
� 

�,���	
�!���2���
����"�
�������+

����,��� Flipchart 

            �+�_�����)�����
�&���� 

            ���&����������
�!�� 

      �+�_�����&3�����"�!�2��* 

                          �+�_���"�����
���������������
��� 

 �+�_���3���	��,����
���������������
��� 

 �+����,���,��&0�,��� Flipchart �&���

������ 

!�"(-�
�(���+/&���!��������(��
)����+��/��%�)���������� Undo  
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11. �����

��
-��#��� (Camera Tool) 

���	�
��	
�
�/!����,��+��+3���_�����!��
��������  

%�)�
!21
����,���+3��/��,��)��&�++ ����
� 

��2��������������
�(��)��&%�) 

 ��2��
�"�!��	
����	�
��	
          �����	
� Camera 

 

 

 

!21
���������	�
��	
(��)��& 

1. ��2���	
���&�++���(��)��& '����
����,��,����&�++ 

�                                             

���,����
+�&0��	���
��
��,�
�)� 

 

 

 

�  

   ���,����
+�&0���&��� %�)����&0�7�����,����&����
� 
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�   

���,��+�2�!6(��)��
+��&����&�++
2��� 

 

 

 

�   

(��)��&���,���"����
��&.�
)��+� Window 

�  

(��)3������,����
 

2. ,��������	
���&�++���(��)��&/�����!  

    �,���2����������,��+�2�!6�
���(��)��& 

    ��������,���	
��-��
���!����&�
�(��)  

�  

!����&�
�,��� Flipchart �
�(��)��&  

(�������,���	
�"�!��	
��
�)  
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�    

!����&�
�,��� Flipchart (��/& 

�   

+�������&�
�(��)/&)�� Clipboard 

�   

+�������&�
�(��)/&)�� My Resources 

�   

+�������&�
�(��)/&)�� Shared Resources 

  3. ��/��3���
�(��)

��� 

��$
#��
  

��+3��"�!���"��) %�)��	
��++ Area Snapshot  

���!��3��+� Current Page 
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12. ���������?�:�����
���'��?�#�
����:!����                 

���� Flipchart 

 (��"�
���������&3�����3�)�
�����2����,��� Flipchart  

 ���/��%�) ��2���������&3��������!��+�,��� Flipchart /������
 

  

 

 

 

 

 

 

��������(&��+�"��,�	
����������"��� # �,���+��&3���
��������+� Flipchart  

/��������
)!��+�����������&3���
���������������
���  

�
�����
����)�������(���/?�*��
)� !2�
%
 �?�� ,�	
/?�*&���3�
	�� # �-���2� 

����2����,��� Flipchart /�� ��!)!21
��
)!����
� ��������(��
)�������7��� ActivInspire /������
 

��2���������&3���
�

"�
������!��/������
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  ���	�
��	
�62"4��"�* 

ActivInspire �
���	�
��	
�62"4��"�*�
����	
���2��,���	
������� /����
)��"� 

������
���!2���62"4��"�*�������� )�������(�����&��)-�"*���/����!2��
	�� # ������� 

 

1. ��!�����������
����������

��
�Q!�������  

    (Math Tool)  

���	�
��	
�62"4��"�*��
)�������	�
��	
   

+����
����	�
��	
,��� 

 

��	�
��	
��
����	�
��	
�62"4��"�* 

���+���	�
��	
�,���	
����(�� 6 ��2�  
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2. �����

��
;�����&�% (Ruler Tool) 

���	�
��	
�
�����
)�/��+��������	
������+�,��� Flipchart  

%�)/��+�����"�!�
������(������/���,�	
�/��+�������2� 

��	�
�����2���	
��
����	�
��	
/��+����� /��+�������&���G������ 

  

 

  ���������/��+����� 

� ��2�������+�2�!6��������/��+����� 

���&0�������	�
�"���,���/��+����� 

� ��2�������+�2�!6&��)/��+����� 

���&0����&��+�����!��)�!/��+����� 

� ��2����,�-�+�2�!6��"������+�,�	
�������� 

���&0����,�-�/��+����� 

� ���"
����"�� %�)��	
����	�
��	
&����          ��!������+�/��+����� 

�����
�"
��"��"��/��+�����%�)
�"%���"2 ��������(��2���
�����/��"����"���� 0 

 

 

��	�
/��"�
����������/��+��������!  

��������(�+/��+�����/�� %�)������/&�2���
�(���)�   
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3. �����

��
;��+���&����
�� (Protractor Tool) 

���	�
��	
�
�����
)�/��%&������"
�*���	
������ 

+�,��� Flipchart %�)/��%&������"
�*"�!�
� 

�����(������/���,�	
�/��%&������"
�*��2� 

��	�
�����2���	
��
����	�
��	
/��%&������"
�*  

/��%&������"
�*��&���G������ 

���������/��%&������"
�* 

� ��2�������+�2�!64��)*���� 

���&0�������	�
�"���,���/��%&������"
�* 

� ��2�������+�2�!6�
+/��%&������"
�* 

���&0����&��+�����
�/��%&������"
�* 

� ��2����,�-�+�2�!6��4�
3�)��/��%&������"
�* 

���&0����,�-�/��%&������"
�* 

 

 

� �����������-� %�)��	
����	�
��	
&����          ��!���-�+�/��%&������"
�* 

�����
�"
���&0��-�"��/��%&������"
�*%�)
�"%���"2  

 

 

 

��������(���/��%&������"
�*/&�2��(���)���	�
�+/��%&������"
�*

� ������
)!��+/��+����� 
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4. �����

��
$
�$,#� (Compass Tool) 

���	�
��	
�
�����
)�!��!
)����	
������+�,��� Flipchart  

%�)!��!
)�"�!�
������("
����!����,�	
�-�/���,�	
�!��!
)���2� 

��	�
�����2���	
��
����	�
��	
!��!
)� 

!��!
)���&���G������+� Flipchart 

  ���������!��!
)� 

� ��2�������+�2�!6��'��),�	
,�!!��!
)� 

���&0�������	�
�"���,���!��!
)� 

� ��2�������+�2�!6�������+��
�!��!
)� 

���&0����&��+����!��!
)� 

� ��2�������+�2�!6�
�)���2��
�
������� 

���&0���������!��!
)� 

� �����
)�!����,�	
�-�  

%�)��	
����	�
��	
&����          ����2�������+��2��
�&0�!���� 

!��!
)���!������!����%�)
�"%���"2  

 

 

 

 

 

��	�
/�����!��!
)����!�����(���/&�2���
�(���)�/��������� 
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5. �����

��
����
'D%�����!% XY (XY Origin) 

 ���	�
��	
�
���������-������2� XY '�������&0��-�,�-�4��)*�����
���&3���-���&+�,��� Flipchart 

 ��	�
�����	
����	�
��	
�
� ��&���G�-�,�-�������+�,��� Flipchart  

,�������������-������2��
�����+�,��� Flipchart  

��	�
���,�-���&�
�
)����,������� #  

��&������-������2��
��&0��-�,�-� 

��������(��2��������-�,�-��
� 

/&)��"���,���"��� # +�,��� Flipchart /�� 

 

6. �����

��
�����V� (Dice Tool)  

��������(�
)����"����	�
�-���"��

������������� 

,�	
�
���	�
��!��������&0�/�� %�)������	�
��	
"�!�
� 

��	�
��2���	
����	�
��	
����"����&���G����"�������� 

  ������������	�
��	
����"�� 

�                                  

����!�����"���
�"�
�����
) %�)��	
�/��"����"�,����(��,����� 

�                                                �!����J!�
�����"���6��
) 

�                       �
)�-���"������"���������,�� 

�                             �����"������"���
��
)/������+�,��� Flipchart 
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���	�
��	
�����������
 

��,�!��
�
�7����� ���/����
)����!21
���������	�
��	
 �������"��� # �����������	�
�
�  

ActivInspire ��	�
,���,�!��
�
���
12+�)(�����������	�
��	
����!)�����������
 

�,��
�!������������)2������ 

 

1. �����

��
�$���#�# (Page Zoom) 

  ��������(�)�),��� Flipchart ����,�	


�/�� 

 %�)������	�
��	
�!���)�) 

 /&�
� View > Page Zoom ���!��2���	
� Page Zoom 

  

  !21
���������	�
��	
�!���)�) 

� ��2�'��)�����
�/!�+�,��� Flipchart 

���&0�����)�)���� 

� ��2��!������
�/!�+�,��� Flipchart 

���&0�����)�)

� 

� ��+�+2����2�'��)+�,��� Flipchart 

���&0����&��+��,��� Flipchart &�"2 

��������(���������	�
��	

	�� # /���6��
����&��+,��� Flipchart 
)�� 

��	�
&|
�����!����+�� ��
��
������������	�
��	

	�� # �������,�&��+����)�)���&0�&�"2 
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2. �����

��
N����
 (Revealer Tool) 

���	�
��	
_��+�����&0��������7�������5��+��,��� Flipchart 

%�)�
���������(��
) # �&.�������	�
,��
����!�/�� 

��2��
�"�!��	
����	�
��	
          �����	
����	�
��	
_��+��  

                                                                    

���
,��������5�
���������&.� Flipchart ����,����
 

  

 

 

 

��������(��2���������5�7���
���	�
�������&.�������	�
,�/�� %�)�����(�&.�/���
������

�������� ���"�
�������&.�����,�����,���2���
)��
���������(�&.�����
	��/�� 
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3. �����

��
��
���;�&� (Spotlight Tool) 

���	�
��	
�&
�*"/��*���&0�����&.�,�	
&.�3���_�����!�  

%�)�
���������(���	�
�"���,���/��  

����)��+���_�)/?_�)/&"��"���,���"��� #  

 ��2��
�"�!��	
����	�
��	
          �����	
��&
�*"/��* 

  

  !21
������	�
��	
�&
�*"/��* 

1. ��2���	
���&�++�
��&
�*"/��* 

2. ��������(&��+�����&
�*"/��*/�� 

%�)��2�������+�2�!6��
+�
������2� 

3. ��������(���	�
�"�!�&
�*"/��* 

%�)��2�������+�2�!6�	���
��
��� 

�&
�*"/��*�++"��� # 
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4. ��[!�� (Clock) 

 ��������(������2��+�,��� Flipchart /�� 

 %�)���2���
��
�������2��1�����������2����+�!�� 

 ��2��
�"�!��	
����	�
��	
            

/&�
� More Tools… �����	
����2��  

  

���2��&���G������+� Flipchart  

 �������"��� # �
����2�� 

�           �������2���++��J� 

�           �������2�����!���
��++"�!��� 

�           �������2�������++��J����"�!������
�����!���
� 

�           ,)-��!���
������
�/!�  

�           ��+�!��(
),��� '�����������(���,���������"��� # ��	�
,���!��/�� 

�           ��+�!����2�,��� ��������(���,���������"��� #  

          ��	�
�!����+(���-��
����,��/�� 

��	�
�����2���	
���+(
),���,�	
��+��2�,�����&���G���
��,����,�����56������& 

 

 

 

 

 

���,���!����+ 

(
),���,�	
��2�,��� 
���,����
)��,�������	�
,���!�� 

���,���,"-���6*�
�����2���	�
,���!�� 
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5. ��
�$������
� (Tickertape) 

 ��������(�����
�!����	�
�+�,��� Flipchart /��  

 ���� ,�!��
+���
)� �"	
��!����� �&0����������
�!���,���2��!���������!21
,���� 

��2��
�"�!��	
����	�
��	
  

/&�
� More Tools… �����	
���
�!����	�
� 

 
 ��&���G���
�"�������,���
�!����	�
� 

 

 

  

 

 

���
� Tickertape Speed  

���
�(+&��+�!����J!�������	�
��
���
�!��  

�������,)-���	�
� �������������/���
�!�� 

 (��&.����
� Tickertape Speed ���&0�����+��
�!����	�
�

� 

��$
#��
 

��
�!����	�
����!�� ActivInspire Tickertape 

  

 

 

�2��*��
�!����	�
��
��
� 

���!��	
� OK 
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6. �����

��
���&/�$!%,+
 (Screen Recorder) 

��������(��J++������2��"��� # �
������+� Flipchart �&0�/?�*!2�
%
/��  

���� +���������
�,�	
���������
 ��	�
���������'���/����	�
) # 

��2��
�"�!��	
����	�
��	
  

/&�
� More Tools… �����	
����	�
��	
+�����!2�
%
 

  

  !21
���+�����!2�
%
 

1. ��	
�&���3��
����+�����!2�
%
 

�                                             +�����!2�
%
����,����
    

�                                             ���,��+�2�!6�
���+�����!2�
%
 

2. ���������&���G���
��������+�����!2�
%
 

         

 

�,���2���	
��
�&-K��
�����	�
������+�����!2�
%
  

��&���G,���"����,�+�����/?�*!2�
%
�
������
� %�)!2�
%
��+������&0�/?�* AVI 
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3. ,��������2���	
� Save ���!����2�����+���������
 

%�)&-K��
����������2+���+�
?|���	�
����!��������+�����!2�
%

)�� 

�2��"��� # �
���������/&��(��+���������!2�
%
����
 

 

 

4. ,��"�
����,)-����+������,���2���	
��
�&-K��
��,�
�)�  

%&�����������!�������)�����������/?�*!2�
%
 

5. ,��"�
��������!2�
%
�
�+��������J����! �,���	
��
�&-K�����  

��������(+�������
)��6�+�����!2�
%
��!)���"�
/�%��%?�������+�
��2!�"
�* 
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7. �����������

��
������ Desktop  

    (Desktop Annotation) 

���	�
��	
"��� # �
� ActivInspire ��������(���+�,��� Desktop  

,�	
+�,���%&�����"��� # ���
��2!�"
�*���/����!) 

���������� Desktop Annotation            �
���
)��+����
����	�
��	
,��� 

��	�
��2��
���������
� ������,��� Desktop �
���� 

���
����
����	�
��	
,������,���"��� Browser 

��������(������	�
��	
"��� # +�,��� Desktop /������
  

��2��
��������           �
�

��������	�
���+��,��� Flipchart &�"2 

��$
#��
 

���&������
)���
�!��+�,��� Desktop 
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����2����������	�
 

 ��,�!��
�-����)�
�������������2����������	�
%�)������	�
��	
"��� # �
�,�!��
�
�7����� 

 Flipchart �
�������������2��,����
� ����2���!����������&0�
)��������	�
������
7��� 

 ������ ActivBoard ����2��,����
�)��&��)-�"*���/����+�����
)�����
����-�!2��

���!) 

1. ���"�
����?�: 

����2��
����&0����'�
���&3��/!�,�����&3��

���&,����  

%�)�
���������(���3���
�'�
�/!�����,�	
���

� 

�����&���"�
�����
���'�
����/����+�����
�)+/!�������/�� 
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����"
��
� 1  ��2��!��
���&����/�� 

   ��	
� Reorder > Bring to Front  

   ��	�
�,���&����/����
)������++��-� ���+����&���/����+�����
�)+ 

 

 

 

 

 

 

 

����"
��
� 2 ��2��!��
���&����/��

������ 

   ��	
� Locked  

   ��	�
�J
���&����/��/���,����	�
��
� ��	�
�����������*/&��2���� 
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����"
��
� 3 ��2���	
����	�
��	
�����*           

��2���������&���/����������
�)+����/&'�
�3�)������/�� 

 

 

 

 

 

 

 

��
)������
�����J�����(�
��������&���/����������
�)+����

�����/��/��%�)
2��� 

��
������ 1. ,���������3��/&'�
����! �,����"���,���3���
�'�
�/!���!) 

   2. 3���
���'�
�"�
��
������J��!��3���
����&.�+��/!�����+� 

       ������"�!
)��� 3������/��"�
��
����3���,$��!����&���/����������
�)+ 

   3. ��������('�
���
�!���"�3��/�� %�)���!21
��
)!��� 

���&��)-�"*��� ����������2���!����������,������	�
,� �,������
)�"2�"���2���
�'�
�
)�� 

���'�
����4���*�����
� '�
�����_�) '�
����(�� '�
��	�
&����4�"��7��
� 

,�	
����&0��2��� ���� '�
�����+��� '�
�
�,����"���)J� �&0�"�� 
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2. �������,����
���-��-����
� 

 ����2��
����&0������������(��-���"
+ %�)����
������,����"
+���(������������)2������ 

 ��$
#��
 

 ���3��"�!
)�������'��) �
���!�� �!���
, 15+20= ��� ��-�����
�
���" 

 ��	�
�����2�����������,����
�/&�	���
��
������2������!���/�����!�� Hello, 35 ��� 50 ��" 

 ���
��
����&0�"�!
)������"�!
)����	
  �&�3�5�/�)�&0�3�5�
���85  �	
 �!���
-Hello 

      ���(��!2���62"4��"�*  �	
 15+20 = 35 

      ���(��!2�������  �	
 ��-�����
�
���"-50 ��" 

 

 

 

 

 

 

��������(��2�����������,����
����+���	���
��
�������'��) ��	�
�������(��/����!) 

����2��
����&0���������
 �,����(�����"
+��	���+�
�	��,���  

���� ��"�!
)��� ���!�� �!���
 ��+ Hello ���!���-�����
)��  

%�)��	�

)������'��)���!�� Hello ����	�/&��+�
���  

�����	�

)�������!����!�� �!���
 ����	�/&�
������2� 
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����"
��
� 1 �����&�
��,�
�)����������
���

����
���& ��	�
����&0��	��,��� 

   Shared Resources > Shared Shapes > Square 

    

 

 

 

 

 

 

 

����"
��
� 2 ��	
����	�
��	
(���
          ���!���
��	�
�&�
�)��
�
��,�
�)������
���& 

"��"�!
)��� ��������
���������'��) ����
������2��������!� 
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����"
��
� 3 �2��*���(�����"
+��+�,��� Flipchart  

%�)�,����(��������"
+�&0�������
�!����� 

"��"�!
)��� �2��*���!�� �!���
, Hello, 15+20=, 35, ��-�����
�
���", 50 ��" 

    

 

 

 

 

 

 

 

����"
��
� 4 ��2���	
����	�
��	
�����*           ���������(�����"
+����
��
)!����,���
)��

������������56�+����� �	
 ���(��
)������+�������"
+
)���������� 
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����"
��
� 5 ��2���	
����	�
��	
(���
          

������ ���
�
����(������
����"
+�,��
�
��
)!���

��+�
�
��
��,�
�)��	��,��������
� ��������"�
�����,��
"�!
��5���	���+�
�	��,��� 

��$
#��
 ���
������2��,���+���(�� �	
 �!���
, 15+20= ��� ��-�����
�
���" 

             ������
����,���+���"
+ �	
 Hello, 35 ��� 50 ��" 

   

 

 

 

 

 

 

����"
��
� 6 ��+�!���-��������"������(�� %�)��2���������
+��������
�  

���!��2���������!���-������
��!         �,��&0��
�,�	
�  

�!���-���-����(�����"
+������!)��� 
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����"
��
� 7 &��+�����
��,�
�)��	��,��������
���& �,��"J������,����
 

 

 

 

 

 

 

 

����"
��
� 8 ��2��!��
��
��,�
�)��
��� �����	
� Locked 

��2��!��
��
��,�
�)��
������2� �����	
� Locked ������
)!��� 

��������/��"�
�����
������	�
�)��)�
��,�
�)������
� 
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����"
��
� 9 �����-������,��!)��� ��/�����(�����"
+���"�!
)��� 

 

 

 

 

 

 

 

 

��
������ 1. "�!��
+�,������!�����(�����"
+/���!���-��������! 

2. �����(&��)-�"*�����+��&3��/�� ���� �
��&3�����
���+���4���*�"�3�� 

���&��)-�"*��� �����2���!����������������������(�����"
+&�"2�,��
�
������)2������  


�����,������
)��&0���������_�)�
��J/�� '���!21
��������(�����"
+�����
�

�����(���/&&��)-�"*���/����+�-�!2�� 
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3.  ��/���

�� (Magic Ink) 

���	�
��	
,�����
�,��
������(������&0�����2������������	�
�
��������"�!,����  

�-������
����	�
��	
�
��	
 ,�����
�,����+�_�����)����&������� 

��)����&����������
�!���������� ��/���+��
�!��,�	
��&3��"��� #  

��$
#��
 

+�,��� Flipchart �
��
�����
�)!��+��	
��!�2� %�)��
���+����!�(��&�����
������2��
���+
)��  

����������,�����
�,�����+�)+�2�!6&�����
������2� ��&���G��
����
�'�
�
)�������� 

 

 

 

 

��������(��	
����	�
��	
,�����
�,�%�) 

��2��
����
����	�
��	
 

��2���	
����	�
��	
,�����
�,� 

  



The ActivClassroom prometheanby64

��$
#��
 

�������������������	�
��	
,�����
�,� 

1. �2��*���!�� ��
�!�� ��+� Flipchart 

  

 

 

2. ��2���	
����	�
��	
&����            

    ��2���	
��
������2����&��+��������/&�
� 86 

 

 

3. ��2��������������2�&.�+����
�!�� 

 

 

 

4. ��2���	
����	�
��	
,�����
�,� �����2���+�)�����
������2�

� 

    ��&���G��
�!�������� 

  

 

 

 

 



The ActivClassroom prometheanby 65

�,����!�������2���"2� 

Promethean Learning 

 �-6�����(,�/
��
)"��� # ����������+���
)�/���
��!J+/'"*

�/��*�����2���
� Promethean 

www.PrometheanLearning.com  

Promethean Planet 

 �!J+/'"*�-�������&�
�)��!�������,!���
����)*���!%���
���� ActivBoard  

 �����(��!�*%,�� Flipchart �����
�����������
��� /��%�)/����
)���������)�� # �����2�� 

 www.PrometheanPlanet.com 

 

"2�"�
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 Hollywood International Ltd. 

 ��!]�& ^
��,$��%
!���
����������� '����% 

Education Technology Division �_���&�+�+�#,����/�]� 

 501/4-8 (������+-�
 ��!�(���$�/� �����!
 ��-�����10400 

%��. (02)653-8555, 653-8255 (30 Lines) "�
 757, 758, 759 

�?�'*. (02)653-9798 

Email: edtech@hollywood.co.th Homepage: http://www.Hollywood.co.th 


